
 

 
 
 
 
 
 

 
 
 
 

 





  Lumenera INFINITY CAPTURE 
Release 4.5  User’s Manual 

Copyright Notice:  
Release 4.5 

Copyright © 2007 Lumenera Corporation.  All rights reserved. 

The contents of this document may not be copied nor duplicated in any form, in whole or in part, 
without prior written consent from Lumenera Corporation.  Lumenera makes no warranties as to 
the accuracy of the information contained in this document or its suitability for any purpose.  The 
information in this document is subject to change without notice. 

 

License Agreement (Software): 
This Agreement states the terms and conditions upon which Lumenera Corporation ("Lumenera") 
offers to license to you (the "Licensee") the software together with all related documentation and 
accompanying items including, but not limited to, the executable programs, drivers, libraries, and 
data files associated with such programs (collectively, the "Software"). 

The Software is licensed, not sold, to you for use only under the terms of this Agreement. 

Lumenera grants to you the right to use all or a portion of this Software provided that the Software 
is used only in conjunction with Lumenera's family of products.  

In using the Software you agree not to: 

a) decompile, disassemble, reverse engineer, or otherwise attempt to derive the source code for 
any Product (except to the extent applicable laws specifically prohibit such restriction); 

b) remove or obscure any trademark or copyright notices. 

 

Limited Warranty (Hardware and Software): 
ANY USE OF THE SOFTWARE OR HARDWARE IS AT YOUR OWN RISK. THE SOFTWARE IS 
PROVIDED FOR USE ONLY WITH LUMENERA'S HARDWARE AND OTHER RELATED 
SOFTWARE. THE SOFTWARE IS PROVIDED FOR USE "AS IS" WITHOUT WARRANTY OF 
ANY KIND. TO THE MAXIMUM EXTENT PERMITTED BY LAW, LUMENERA DISCLAIMS ALL 
WARRANTIES OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT 
LIMITATION, IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, QUALITY 
AND FITNESS FOR A PARTICULAR PURPOSE. LUMENERA IS NOT OBLIGATED TO 
PROVIDE ANY UPDATES OR UPGRADES TO THE SOFTWARE OR ANY RELATED 
HARDWARE. 

 

Limited Liability (Hardware and Software): 
In no event shall Lumenera or its Licensor's be liable for any damages whatsoever (including, 
without limitation, incidental, direct, indirect, special or consequential damages, damages for loss 
of business profits, business interruption, loss of business information, or other pecuniary loss) 
arising out of the use or inability to use this Software or related Hardware, including, but not 
limited to, any of Lumenera's family of products. 

 

Product Warranty 
Lumenera Corporation warrants to the original purchaser that our cameras are guaranteed to be 
free from manufacturing defects for a period of one (1) year from the original date of purchase.  
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Should the unit fail during the warranty period, Lumenera will, at its option, repair or replace the 
failed unit. Repaired or replaced units will be covered under warranty for the remainder of the 
original one (1) year warranty period. 

This warranty does not apply to units that, after being inspected by Lumenera, have been found 
to have failed due to customer abuse, accidents, mishandling, tampering/alteration, improper 
installation, improper power source, negligence, opening of the enclosure, or if the serial number 
has been removed or damaged. This warranty does not cover labor or incurred charges required 
in removing or installing the unit, any business interruption, loss of profits/revenues, or any 
consequential damages.  

Units returned to Lumenera beyond the warranty period will be repaired, if possible, and all 
appropriate material and labor charges will apply. 

Any returning product, specifically those being returned under warranty, must follow the Returned 
Material Authorization (RMA) process. Any units being returned are to be properly packaged (in 
original packing – if possible). Lumenera will not cover damage sustained in shipping due to 
improper packing. 

For RMA instructions, please refer to our website at www.lumenera.com. 

 

RoHS/WEEE Compliance Statement 
The Restriction of Hazardous Substances in Electrical and Electronic Equipment (RoHS) 
Directive was passed into law by the European Union (E.U.). It affects manufacturers, sellers, 
distributors and recyclers of electrical and electronic equipment containing lead, cadmium, 
mercury, hexavalent chrome, polybrominated biphenyl (PBB) and polybrominated diphenyl ether 
(PBDE). After July 1, 2006 the use of these materials will be banned in new products sold in 
Europe. The RoHS Directive complements the WEEE Directive. China is expected to adopt 
similar legislation within a similar timeline. 

The Waste Electrical and Electronic Equipment Directive (WEEE) aims to reduce the waste 
arising from electrical and electronic equipment and to improve the environmental performance of 
all those involved in the life cycle of these products. 

Lumenera is committed to protecting people and the environment and we are working on 
identifying any materials used in our processes that could pose a potential hazard to our 
employees, customers or the environment. 

For this reason we are committed to have all our products comply with the RoHS and WEEE 
directives. We are constantly improving our compliance with these directives. For more 
information on our compliance or to track our progress please refer to our website. 

 

Trademarks and Proprietary Names: 
Lumenera Scientific, INFINITY X, INFINITY 1, INFINITY 2, INFINITY 3, INFINITY 4, INFINITY 5, 
INFINITY1, INFINITY2, INFINITY3, INFINITY4 and DeltaVU are trademarks of Lumenera 
Corporation.  This manual may refer to other product names, which may be trademarked by their 
respective companies, and are used herein for identification purposes only.  
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Federal Communications Commission (FCC) Statement 
This equipment has been tested and found to comply with the limits of a Class B digital device, 
pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a residential 
environment.  This equipment generates, uses, and radiates radio frequency energy, and if not 
installed and used in accordance with the instructions, may cause harmful interference.  
However, there is no guarantee that interference will not occur.  If this equipment does cause 
interference to radio or television reception, which can be determined by turning the equipment 
off and on, the user is encouraged to correct the interference by one of the following measures: 

 
• Reorient or relocate the receiving antenna.  
• Increase separation between the equipment and receiver.  
• Connect the equipment into an outlet on a circuit different from which the receiver is 

connected.  
• Consult the dealer or an experienced radio/TV technician. 

 
Any changes or modification to said product not expressly approved by Lumenera could void the 
user's authority to operate this device. 
 
Shielded and grounded cables and connectors must be used to meet FCC emission limits.  
Lumenera takes no responsibility for any radio or television interference caused by using cables 
or connectors other than those recommended. 
 
This device complies with part 15 of the FCC Rules.  Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause undesired operation. 

 
European Community (CE) Statement 
Products: INFINITY 1, 2, 3, 4, 5, X, Lu1175, Lu1175X, Lu1205, Lu1135, Lu1165, Lw1235, 
Lu1275, Lu1335, Lu1375 and Lw1625 USB Scientific Cameras. 
 
Directives: 2001/59/EC (General Product Safety Directive) Self-declared 89/336/EEC (EMC 
Directive). 
 
Standards to which conformity is declared:   EN55024: 1998 

EN55022: 1998 (Class B) 
EN61000-3-2: 1995 
EN61000-3-3: 1995 

 
Manufacturer’s Name and Address:  Lumenera Corporation 

7 Capella Court 
Ottawa, ON 
K2E 8A7 
Canada 

 
Type of Equipment:  USB 2.0 Scientific Digital Camera 
 
First Year of CE Conformity: 2003 
 
This is to certify that the Lumenera USB 2.0 Scientific Cameras meet or exceed the standards for 
CE compliance per the Council Directives noted above.  All equipment is built at Lumenera 
Corporation, and pertinent testing documentation is available for verification. 
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1 1 
Introduction 

1.1 The Lumenera INFINITY Camera Family 

Lumenera INFINITY cameras are designed to be flexible microscopy imaging 
tools for Clinical, Research, Life Science, Materials Science and Educational 
Professionals.  INFINITY cameras are compatible with any USB 2.0 equipped 
desktop, laptop or embedded computer running Microsoft Windows 2000 or XP. 
INFINITY cameras are designed with flexibility in mind.   Each camera model has 
its own distinct advantage over the others.  Whether your application demands 
speed, resolution or sensitivity, there is an affordable INFINITY camera to meet 
the requirements.  Because they are USB based, there is no need for a frame 
grabber.  Instead, a single cable provides power*, full command and control and 
data transfer at speeds of up to 40 MB/s resulting in real-time video preview. 
All cameras have a provision to be externally powered for cases where the USB 
cable does not supply power (e.g. some USB cards on laptop computers.)   
The INFINITY cameras have undergone a recent naming change.  The following 
table provides a cross reference between the old and new names: 
 

Old Name New Name 
INFINITY 1 INFINITY1-1 

INFINITY 2 INFINITY2-1 

INFINITY 3 INFINITY1-3 

INFINITY 4 INFINITY2-3 

INFINITY 5 INFINITY3-1 

 
* The original INFINITY 2, 4, 5 and X models should be used with an external 6V power adapter 
(supplied) due to their higher current requirements.   

* The new INFINITY2-1, 2-2, 2-3, 3-1, 4-11 should be used with an external 5V power adapter 
(supplied) due to their higher current requirements. 
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2  
Getting Started 

2.1 Software Installation 

The INFINITY camera you have just purchased is designed to operate out of the 
box with minimal set-up.   
Note: Prior to plugging the camera into the computer, you must first install the 
software. 
The software can be found on the CD-ROM that shipped with your product. 

2.1.1 Minimum System Requirements 
• Windows 2000 (Service Pack 4), or 

• Windows XP (Service Pack 2) 

• 600 MHz Pentium III or higher (compatible) 

• 256 MB RAM minimum, 512 MB recommended 

• USB 2.0 Port.  
Note: A USB 2.0 Port is required.  The camera will not work on a 
standard USB 1.1 port. 

2.1.2 Camera Power Requirements 
The camera can typically run off of the USB bus. In some cases and/or camera 
models, there may be a need to externally power the camera. Please refer to 
Section 1.1 for more information on selecting the appropriate power supply for 
your camera. If an incorrect external power supply is used, it could damage the 
camera and void your warranty. 

2.1.3 Installation Procedure 
The INFINITY camera you have just purchased is designed to operate straight 
out of the box.  However, prior to plugging the camera into the computer it is 
recommended that you first install the software, which is included on the CD-
ROM that shipped with your product. Follow the steps below for simple 
installation: 
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Installation Steps: 

1. If you are using a 3rd party USB 2.0 PCI add-in card, please ensure 
the add-in card is properly installed on your computer before 
proceeding.  

2. You must ensure you are logged into the computer with administrator 
privileges prior to continuing the installation. 

3. Close all application software that is running and then insert the INFINITY 
Installer CD into your CD-ROM drive. 

4. Double-click on “setup.exe”, or wait a few moments for the auto-play 
function to load the setup program automatically. 

5. Follow the onscreen prompts to install the software drivers and user 
application.  

6. After the software has been installed, plug the INFINITY camera into a 
free USB 2.0 High-Speed port. 

7. Windows 2000 & XP Users: 
a. The Window’s New Hardware Wizard will pop-up detecting a new 

“INFINITY Unconfigured Device”. Select “Install the software 
automatically” from the options that are presented to you and click 
Next. A warning may appear notifying you that the drivers have not 
been digitally signed by Microsoft. Click Continue Anyway to continue 
with the driver installation. Then click Finish to install the drivers. 

b. After a few seconds the Window’s New Hardware Wizard will pop-up 
again (if it doesn’t, unplug and re-plug the camera device), detecting a 
“INFINITY USB 2.0 Camera” device. Select “Install the software 
automatically” from the options that are presented to you and click 
Next. A warning may appear notifying you that the drivers have not 
been digitally signed by Microsoft. Click Continue Anyway to continue 
with the driver installation. Then click Finish to install the drivers.   
(Please Note: Depending on the camera model purchased the string 
“USB 2.0” may be different than noted above. 

c. Important: Windows will ask you to re-run these steps each time you 
plug the camera into a new USB 2.0 port. You must have administrator 
privileges the first time the camera is used on any given USB 2.0 port. 
You may wish to repeat these installation steps at this time for all USB 
2.0 ports. 

8. Run the INFINITY CAPTURE application software from your Start menu to 
control the camera.  
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2.1.4 Software Upgrade Procedure 
The Software Upgrade procedure is similar to the original software installation. If 
you have installed a previous version of the software the installation procedure 
will detect the previous software version and indicate that an upgrade.will be 
performed.  

2.2 Technical Assistance 

If you need assistance with the installation or use of the software, or, if you need 
help with general camera operation, please contact your retailer or dealer first. If 
you still need assistance you can contact the Technical Assistance Centre (TAC) 
via email at: 
    support@lumenera.com 
 or by phone at +1-613-736-4077 (press 2 from the auto attendant) 
 
To obtain the latest software release and other technical information you may 
visit our technical support website at: 

http://www.lumenera.com/support/index.php 
Our support website contains technical information available to the general public 
such as Frequently Asked Questions (FAQ’s).  For our Lumenera customers we 
provide a Knowledge Base with more product specific solutions and a Download 
Centre for customers to obtain the most recent software releases. 
As a customer, you will need to provide the TAC with some basic information to 
gain access to the customer Knowledge Base and the Download Centre.  Please 
provide the following details via email to support@lumenera.com  to obtain a 
user name and password: 

• Your name, Company Name, address and telephone number 

• Your camera model and serial number 

• Your purchase information (e.g. did you purchase from an OEM or 
distributor?) 

Upon providing the above information, you will receive your access information 
via email from a TAC representative. 

2.3 Installed Software 

All of the necessary software and device drivers are contained in an installation 
program on the CD-ROM that comes with the camera.   
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The following files are installed when you run the installation program: 
INFINITY CAPTURE Application:  Lumenera provides a free, easy to use 
capture application with all of the features required for basic camera functionality 
and image capture. 
INFINITY ANALYZE Application: Included on this CD is Lumenera’s new 
INFINITY ANALYZE software. The new INFINITY ANALYZE software provides 
advanced camera control, measurement functions and image enhancement 
options including stitching, annotation and archiving. The application has 
extensive context sensitive help for all its features. 
INFINITY TWAIN Interface: A plug-in driver will be installed by the installation 
program that will allow all INFINITY cameras to be used with any 3rd party 
software application that supports a TWAIN device.  
INFINITY DirectShow Interface: Filter drivers will also be installed by the 
installation program that will allow all INFINITY cameras to be used with any 3rd 
party software application that supports DirectShow / DirectX / WDM capture 
devices.  

2.4 The INFINITY Camera 

All INFINITY cameras have a power jack and a high-speed USB port found on 
the back of the camera.  After powering the camera, simply plug it into a USB 2.0 
(high-speed) compatible port and the camera will be functional.  An LED light 
between the power jack and USB port will indicate power is reaching the camera 
and that the camera is running.   
The INFINITY 1, 1-1, 3, 1-3 and 1-5 can be powered via the USB cable alone, 
which nominally supplies 5 volts.  For these models, the power adapter is only 
required in cases where the USB cable does not supply power (as is the case 
with some laptops.)   
For all other INFINITY models, the supplied power adapter should be used to 
power the camera, as the power supplied by the USB bus is not sufficient for 
optimum performance. 
The power adapter supplied* has the following specifications: 

1. 5, 6 or 12 Volts DC Regulated (Depending on Model) 
2. 500-3000 mA Minimum Current Rating (Depending on Model) 
3. 2.1 mm tip, Center positive (+) 

The camera is equipped with an industry standard C-Mount lens mount, which is 
compatible with standard C-Mount lenses or microscope mounts.  The 
INFINITY4-11 comes equipped with an F-Mount instead of a C-Mount. An 
adapter may be necessary for microscopes that do not have this type of camera 
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mount. In some cases, a C-mount adaptor may be required to optimize the field 
of view between your microscope’s eyepieces and the image viewed on the 
computer monitor.  Your sales representative will recommend an adaptor to suit 
your requirements. 
The INFINITY X camera is unique in that it utilizes DeltaVU™ a patent-pending 
technology that increases the resolution of captured images to as much as 21 
megapixels (5120 x 4096) with true non-interpolated color at each pixel location. 
 
*Power adapter not included for client’s outside North America.   
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3  
Using the Camera 

3.1 INFINITY CAPTURE 

INFINITY CAPTURE is a powerful and flexible yet simple software application for 
the Live Preview, Optimization and Capture of digital images from any of the 
INFINITY cameras.   
It is supported by Windows and has a graphical user interface with standard pull 
down menus, an icon based toolbar and keyboard commands, which make it 
very simple to control the camera and take images.   
The following sections describe the usage of the software and explain the various 
camera settings and how they relate to the changes viewed in the live and 
captured images.  

3.2 Launching the Application 

To launch INFINITY CAPTURE from your Windows Start menu: 

      or  
Select:     Programs > INFINITY Camera > INFINITY Capture. 
(If you installed the software in a different location, the above instruction will be 
different based on the location you chose.) 
Only one camera may be controlled by each instance of INFINITY CAPTURE, 
but several instances of the application may be run simultaneously.  If more than 
one camera is detected by the application, a list of cameras and their 
corresponding serial numbers is displayed allowing you to select the camera you 
wish to control.  

3.2.1 Main Window 
The main window can be seen in Figure 1.  When INFINITY CAPTURE starts up, 
the program’s live preview window also starts.  The main window has the toolbar 
with the most common program actions available for quick access. 
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Figure 1 - INFINITY Camera Main Window 

3.3 Selecting Image Size 

3.3.1 Image Preview Size 
You may choose any one of the available resolution settings from the drop down 
list on the main window for video preview as depicted in Figure 2.  Depending on 
the camera model, the available selections will be different.  The default 
resolution on start up is 640 x 480.  The video frame rate displayed on your 
monitor will vary depending on the choice of preview resolution.  With each step 
down in resolution, you will utilize a smaller area of the camera’s sensor (smaller 
field of view) resulting in less video data and increased frame rates.  The 
exception to this is the sub-sampled mode, which utilizes the entire area of the 
sensor (full field of view) but skip rows and columns of pixels to reduce the 
amount of image data.  In some cameras, a binned mode is available which 
works in a similar way to the sub-sampled mode except the pixels are summed 
together to produce a brighter, more sensitive image. Using this mode results in 
a megapixel image area at higher frame rates but with less detail.  Note: some 
camera models only provide a monochrome output when operating in a binning 
mode. 
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Figure 2 - Image Preview Size 

3.3.2 Capture Resolution 
Image capture resolution is selected through the drop down list in the main 
window similarly to the Image Preview Size.  Capture resolution is independent 
of preview resolution.  This represents the resolution of the image that is 
captured.  
The INFINITY X camera has 4 different DeltaVU™ resolutions available for each 
preview resolution (in addition to the standard “Demosaic” method used by all 
other cameras.)  This patent pending technology allows for much higher 
resolution captures by performing sub-pixel shifting of the imager.  
The preview and capture resolutions can be locked so that they both change 
when changing either one. 

    
Figure 3 - Resolution lock 

Copyright © 2007  Page 9 



Lumenera INFINITY CAPTURE   
User’s Manual  Release 4.5 

3.4 Image Optimization 

3.4.1 Exposure 
Optimizing the exposure of your INFINITY camera is achieved through moving 
the exposure slider, Figure 4.  Based on the camera model, you have different 
exposure ranges available.  Fine exposure slider adjustments can be made using 
the left and right arrow keys on your keyboard when the exposure slider is 
selected.   As exposure is adjusted, the frame rate is kept at the maximum 
possible. 
Some cameras have an extended exposure range, indicated by an Extended 
Range check box just above the exposure slider.  When not in extended 
exposure mode, the exposure is limited but has high granularity so that very 
precise exposure settings can be made.  When the option is selected, the 
exposure can be increased to the maximum allowed by the camera, but with less 
granularity.   

Note: If you have image averaging turned on and are using 
long exposures, you may have to wait a long time to capture 
an image. Also, when using very long exposures (several 
seconds) especially with high gain, noise may be present in 
the image in the form of random hot pixels and vertical bars. 
These can be minimized by using the flat field correction 
function of the application. 

3.4.2 Gain 
Adjusting the global electronic gain of your INFINITY camera increases the 
sensitivity without increasing the exposure.  The slider is under the exposure 
slider on the main window as depicted in Figure 4.  The global gain of each 
INFINITY camera model is optimized on start up.  General image quality may 
decrease as the gain is adjusted upward because the noise in the image is also 
amplified along with the image signal.  
 

 
Figure 4 - Exposure and Gain Control 
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Note: When using very long exposures (several seconds) 
especially with high gain, noise may be present in the image 
in the form of random hot pixels and vertical bars. These can 
be minimized by using the flat field correction function of the 
application. 

3.4.3 Selecting the Light Source 
Each light source emits light at a specific frequency resulting in a specific color 
temperature.  Color temperature measurement is typically referred to in degrees 
Kelvin (K).  Warmer tungsten / Halogen light sources have temperature in the 
3000 K range.  Fluorescent light sources have a temperature in the 4000 K range 
and daylight conditions have cooler color temperatures in the 5500 K range.  

 

Figure 5 - Selecting the Light Source 
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Your INFINITY camera is set to Tungsten / Halogen as a default. Selecting the 
light source that best suits your working environment will help in optimizing your 
images.    
From the Options menu, you can select the light source as depicted in Figure 5.  
Select Tungsten / Halogen for microscopy applications.  When working in the 
field, outdoor lighting conditions with a standard lens, select the Daylight source. 
When working indoors, office environment with fluorescent lighting, select the 
Fluorescent source.  
If you are using filters on the light source, you should choose the light source that 
best matches the filter.  For example, on a microscope with Tungsten lighting, if 
you use the standard daylight filter, you should select Daylight as the light 
source. 

3.4.4 White Balance Target 
Your INFINITY color camera has the ability to adjust the colors in your image 
based on the current lighting conditions.  In order to adjust and accurately 
represent the colors within your image, you must first perform a white balance.   
As a first step, select a light source that accurately represents your working 
conditions, described above.  Next, select a target color that most accurately 
represents the current working conditions.  For a microscopy application this will 
be the background color when viewing a sample through the eyepieces.  
The default target color on start-up is white and in most cases this is the desired 
choice.  However, when viewing an image with the microscope eyepiece, 
especially when color filters are being used, the background color is sometimes 
non-white.  If you want the colors captured by the camera to be as close as 
possible to the colors you see down the eyepiece you should select a color target 
from the Available White Balance Target Colors that closely matches the 
background color.  The target color dialog can be accessed by selecting the 
“bull’s eye” icon from the toolbar or from the dropdown menu as depicted in 
Figure 6.  
 

 

 
Figure 6 - White Balance Target Dialog Access 
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You can select a target color, simply by clicking or dragging the mouse pointer in 
the top window of the dialog depicted in Figure 7.  The selected color appears in 
the bottom window.  Alternatively, you can select the Red, Green and Blue 
values of the color. 

  
Figure 7 - White Balance Target Dialog 

3.4.5 White Balance 
There are three methods available to adjust the white balance: 
1. One Shot Global 
This method balances the colors over the entire field of view.  For best results, 
move your sample out of the field of view.  If you are using a transmitted light 
microscope, move to a clear area of the slide.  If operating a stereomicroscope, 
use the white base or a white piece of paper to represent the background.  
Perform the One Shot Global White Balance function by selecting the Globe icon 
from the toolbar, or by selecting One Shot Global from the Camera > White 
Balance drop down menu as depicted in Figure 8.  
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Figure 8 - White Balance / One Shot Global 

2. One Shot Spot 
Under certain circumstances, users may wish to adjust white balance based on a 
small area within the sample area.  In these cases, One Shot Selection is the 
method of choice.  To access the One Shot White Balance, select the crosshair 
icon from the toolbar, or select One Shot Spot from the camera drop down menu 
as depicted in Figure 9. 
Once selected, move the cursor to the area of your image that you want to white 
balance (the mouse pointer changes to a cross hair when the mouse is in the 
image preview window) and select it.  The size of the spot on the image used for 
the white balance is 32 x 32 pixels.  You can cancel the operation prior to clicking 
on the image display by reselecting the icon or menu item. 
 

 

 
Figure 9 - White Balance / One Shot Spot 

3. Adjust Manually 
It is possible to manually adjust the color balance by changing the individual color 
gains.  This is helpful where slight adjustments to the white balance are required 
or when the One Shot methods are unable to achieve a good balance.  The 
sliders that control the red, green and blue gains can be accessed via the 
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tricolour icon on the toolbar or by selecting Adjust Manually from the Camera > 
White Balance drop down menu as depicted in Figure 10. 
 

 

 
Figure 10 - White Balance / Adjust Manually 

Not all cameras have a green gain adjustment.  In those cases, simply adjust the 
Red and Blue gains together, higher to remove green and lower to add green.  
The gain values represent multiplicative factors.  The Initialize button will set all 
gains to one and the Reset button will reset the gains to the values they had 
when the dialog was popped up. 
 

 
Figure 11 - Manual Gain Adjustment Dialog 

 
Note:  If you use an extreme white balance target color, a 
proper white balance may not be achievable using the one 
shot or manual methods.  Likewise, under extreme lighting 
conditions (very warm or very cool) proper white balance 
may be difficult to achieve.  In the latter case, try using a 
color filter to bring the light temperature closer to the daylight 
standard of 5500K.   
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3.4.6 Hue and Saturation 
Hue is a term typically used to describe the tone in your image.  Adjusting the 
hue changes the appearance of the image by shifting the color spectrum 
incrementally.  It’s not a substitute for white balance but can be used to give 
images a warmer or cooler tone.  
Saturation typically refers to the dominance of color intensity within your image.  
A low saturation image looks dull and adding saturation can make the colors 
more vibrant. 
The dialog for Huw/Saturation adjustment can be accessed via the rainbow icon 
on the toolbar or by selecting Hue/Saturation from the Camera drop down menu. 
 

 

 
Figure 12 - Hue / Saturation Dialog 

 
The sliders are used to adjust the hue and saturation, increasing when moved to 
the right and decreasing when moved to the left.  By moving the saturation slider 
all the way to the left, all color is removed from the image making it appear 
monochrome or grayscale.  The Initialize button will set the Hue & Saturation to 
zero and the Reset button will reset the Hue & Saturation to the values they had 
when the dialog was popped up.      

3.4.7  Contrast / Brightness / Gamma 
The dialog for Contrast/Brightness/Gamma adjustment can be accessed via the 
light bulb icon on the toolbar or by selecting Contrast/Brightness/Gamma from 
the Camera drop down menu. 
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Figure 13 - Contrast / Brightness / Gamma Dialog 

Adjusting the contrast affects the brightness relationship between the dark and 
light areas in your image.  Adjusting the slider to the right increases contrast, 
making dark areas darker, bright areas brighter and eliminating brightness levels 
in between.  Moving the slider to the left decreases contrast causing the 
brightness of the image to become more uniform and flat. 
Adjusting the brightness affects the overall image intensity. Moving the slider to 
the right and left makes the image brighter and darker respectively.  
Gamma adjustment affects the bright, dark and between areas of your image in a 
non-linear fashion.  The purpose of gamma is to correct the non-linearity in most 
display devices.  Gamma values greater than 1.0, will brighten the darker areas 
of an image without over brightening the bright areas.   For most monitors, a 
good gamma value will be lie in the range 1.3 to 2.0. 
The Initialize button will set the Contrast and Brightness to zero and the Gamma 
to one.  The Reset button will reset the Contrast, Brightness and Gamma to the 
values they had when the dialog was popped up. 

3.5 Capturing an Image 

3.5.1  Capture Image 
There are two steps to capture and save an image.  

• First, select if you want to set the camera into 16 bit mode by selecting this 
option from the Options menu 

• Next, select the Capture Image Icon to capture the image and display it on 
screen. 

• Finally, select the Save Captured Image Icon to save it to disk.  
These commands are also available from the drop down menu. 
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Figure 14 - Capture and Save Image 

• You have a choice of four file types to select from when saving 8 bit 
images and two file types for 16 bit images.  JPEG and Bitmap file types 
do not support 16 bit image saves.  Note that JPEG images are 
compressed and there will be some loss of image detail with that format.  
All other formats are uncompressed with no loss of image detail. This 
application uses the default JPEG compression ratio provided by your 
Windows operating system. This application does not allow you to change 
this compression ratio. 

 

 
Figure 15 - Image Saving File Formats 
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3.6  Other Options 

3.6.1 Light Source Frequency 
The light source frequency settings simply limit the available exposure times that 
can be used in order to avoid the flickering or banding caused by lights operating 
on AC power sources.  When using DC powered lights, as most microscopes 
have, the DC setting may be selected and there will be no restriction on the 
allowable exposures.  When an AC power source is used for the illumination, the 
appropriate frequency should be selected from the choices 60 Hz or 50Hz.  

Note: This option is disabled when AEC is turned on. 

3.6.2 Preview Quality 
The video displayed in the preview window can be set to either: “Optimize for 
Speed” or “Optimize for Quality”.  The default setting is for best image quality, 
which uses a higher percentage of the CPU and may result in a slightly slower 
video rate on some slower computers. When the “Optimized for Speed” option is 
selected, the image quality is noticeably poorer, but CPU usage is minimized and 
frame rates are always at their maximum.  This setting does not affect how 
images are captured.  Captured images always use the highest quality 
algorithms to process the raw data from the camera into full color images. 

3.6.3 Preview Zoom Level 
The preview window can be set to “Actual Size (100%)”, which will display the full 
field of view at its actual size.  Selecting “Half Size (50%)” will shrink the display 
50% in each direction while maintaining the full field of view.  This option is useful 
when previewing large resolutions that are larger than the monitor’s display size.  
A digital zoom is applied to the camera output when zoom factors larger than 
100% are selected.  Whenever the preview image cannot fit on the computer 
monitor, the application adds scroll bars to the side and bottom of the window, for 
navigation.  The available zoom factors are: 25. 50, 100, 200, 400, and 800%.  

3.6.4 Flat Field Correction 

3.6.4.1 Generate Image  
Flat Field Correction is used to correct for uneven lighting and other fixed pattern 
non-uniformity in the image. This action is used to generate the correction to be 
applied to the image.  Before selecting it, you should make all your imaging 
adjustments (exposure, gain, etc.) and then remove any sample from the field of 
view so that you only have an empty “background” image.  Once the correction is 
generated, it can be applied using the “Enable Correction” option.  
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3.6.4.2 Load Image 
Calibration images that have been previously collected can be restored using 
this function.  Only calibration files that are known to be appropriate for the 
existing lens and illumination conditions should be loaded.  If there have been 
any alterations to the optics or the lighting, a new flat field calibration should be 
performed. 

3.6.4.3 Save Image 
Use this function to save a flat field calibration image to disk, to be restored for 
use during another session, or after the lens and lighting conditions have been 
returned to the state when the calibration was performed 

3.6.4.4 Enable Correction 
This action applies the flat field correction that was generated in the previous 
action.  When enabled, the correction will be automatically applied to both the 
live preview and the captured image.  If you change the resolution of the 
preview, the correction will be reset and disabled.  If you change the field of 
view, by selecting a different objective lens, for example, you should regenerate 
the correction for the new field of view.  

3.6.5 Image Flipping 
 

 
 

Image flipping (vertical) and mirroring (horizontal) are available from the Options 
drop down menu or the left-right, up-down arrow icons on the toolbar.  Selecting 
these options will flip the preview image 180° either vertically or horizontally.  
This option also affects the captured image. 

3.6.6 Multiple Image Averaging 
This feature is accessed through the Options drop down menu.  Image averaging 
is an effective tool to reduce random noise in your images.  To enable this 
feature, you select the Multiple Image Averaging option from the Options Menu.   

3.6.7 Multiple Image Settings 
You can change the number of images that are averaged together using the 
Multiple Image Settings Dialog, which is accessed by selecting the Multiple 
Image Settings option in the Options menu.   
When enabled, every time you capture an image the number of images you 
selected will automatically be collected and averaged together. 
This feature is not supported by the INFINITY X when capturing high-resolution 
(DeltaVU™) images. 
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3.6.8 Preview Histogram 
 

 
 

A real-time intensity histogram can be overlaid on the preview window.  This 
histogram can be used as a guide to setting the image properties such that the 
full dynamic range of the image sensor is being utilized.  To display the preview 
histogram, select Preview Histogram from the drop down Options Menu or select 
the histogram icon from the toolbar. 

3.6.9 Highlight Saturated Pixels 
This option allows you to highlight the pixels in the image that are at or near 
saturation.  Saturation in this case refers to the brightness of the pixel.  The 
upper 5% of pixel values will be changed to the selected color and as they get 
closer to their saturated value and will get progressively darker as they reach 
their saturation level.   

 
Figure 16 - Saturation Overlay Dialog 

There are four highlight color options available for color cameras: black, red, 
green and blue, as shown in Figure 16. Only black highlights are available for 
monochrome cameras. A count of saturated pixels can also be presented in the 
video preview window by selecting the Display pixel count option.  
To highlight saturated pixels and/or count them, you need to select the Highlight 
Saturated Pixel option on this dialog. 

3.6.10 Bitmap Overlay 
Any arbitrary bitmap can be overlaid on the live preview display or captured 
image.  A set of digital reticles is included with the application that can be used 
for measurements or to aid object indexing and alignment. Figure 17 shows the 
Bitmap Overlay Control dialog box. 
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Once the bitmap is loaded, you select from the Options Menu to overlay on the 
preview image and/or the captured image. 
You can also create your own bitmaps to overlay, using any paint program.   The 
bitmap must have a width that is evenly divisible by four and must be in RGB24 
format, but other than that, there are no restrictions.  Any part of the bitmap that 
is pure white (RGB = 255, 255, 255) will be transparent with any other color 
overlaying and replacing the image data. 
If the overlay is smaller than the preview or captured image, the overlay can be 
placed in nine specific locations using the Position radio buttons.  
The overlay can be selected to appear on either the live preview or on the 
captured images, or both.  The Options menu lists both of these options, and 
they are also available on the Overlay dialog. 
The overlay can also take advantage of Alpha channel blending. The Alpha 
blending dictates how much of the image is seen through the overlay. You can 
make the overlay transparent, opaque or anywhere in between globally or use an 
Alpha blending bitmap file to use different blending values across the images.  

 
Figure 17 - Bitmap Overlay Control Dialog 

An alpha blending bitmap can be used whenever an overlay bitmap is being 
used.  This bitmap affects the way the overlay bitmap is actually overlaid.  It is 
often undesirable to have the bitmap completely obscure the image data.  The 
alpha blending bitmap will cause the overlay to blend with the image data making 
it less obtrusive.  It can also be used to make a solid bitmap, like a logo for 
example, into a watermark that can be used to tag images without hiding the 
image underneath it. 
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The alpha bitmap has the same restrictions as the overlay bitmap, and must be 
the same size as the overlay bitmap.  The way it works is as follows:  The value 
of each pixel in the alpha bitmap indicates the level of transparency of the pixel at 
the same location in the overlay bitmap.  Pixels that have a value of 255 are 
treated as completely transparent so that only the pixel from the original image is 
used.  Pixels that have a value of zero are treated as completely opaque so that 
only the pixel from the overlay bitmap is used.  The transparencies of the pixels 
in-between vary linearly with their value.  The blending is done independently for 
each of the three color-channels (R, G & B), which allows for some interesting 
effects, such as changing the color of the overlay, not just blending it with the 
image. 
The reticles bitmaps included with the application can be used as their own alpha 
blending bitmaps.  If you use any one of the gray reticles, they will simply blend 
the colored reticles into the image to varying degrees.  The dark gray will blend a 
little bit, the gray will blend half and half and the light gray will blend a lot.  For 
interesting effects, try experimenting with using the color reticles as alpha 
bitmaps. 

3.6.11 Keep Main Window On Top 
This option forces the main application window to remain in front of all other 
windows on the desktop. 

3.6.12 Load Camera Settings / Save Settings / Save Settings As 
 

 
 

At any time, you can save the current settings of the camera and application to a 
file for later retrieval and use.  When the application exits, it saves the current 
settings to a file that is automatically loaded the next time it is run.  With your own 
settings files, you can quickly jump between different resolutions, exposures etc. 
Save Settings, will save the settings to the currently loaded file (if it exists).  Save 
Settings As, allows you to use a different file. 

3.6.13 Restoring The Main Dialog Position 
At any time, you can restore the location of the INFINITY CAPTURE main dialog 
on your desktop by selecting the Restore Main Dialog Position option of the 
Window menu, as shown in Figure 18. This option will move the dialog box back 
to the center of your desktop. 
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Figure 18 - Restore Main Dialog Position Option  

3.6.14 Restoring The Live Preview Dialog Position 
There may be times when you need to move the live preview window around on 
your desktop. You can restore its position by selecting the Restore Live Preview 
Position option from the Window menu.  This option will move the live preview 
window to the upper left position of your desktop. 
 

 
Figure 19 - Restore Live Preview Position Option 

3.6.15 Restoring The Image Preview Dialog Position 
There may be times when you need to move the image preview window around 
on your desktop. You can restore its position by selecting the Restore Image 
Preview Position option from the Window menu.  This option will move the image 
preview window to the upper left position of your desktop. 
 

 
Figure 20 - Restore Image Preview Position Option 

3.6.16 Auto-Saving Captured Images 
The auto-saving feature of the INFINITY CAPTURE application saves every 
captured image into a specified directory of your choice using a common file 
name. Each image file is numbered and can start at any number and have a 
specified number of digits.  
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Figure 21 - Auto-Saving Option 

The auto-saving dialog provides some options to how the files are saved. The 
save directory, filenames and file types can be selected. You can chose to 
overwrite any existing file or continue from an existing set of captured images.  
Each saved image will have the same filename with an appended number. This 
number can start anywhere and can have any number of digits. The only 
restriction is that the final filename (filename, digits and extension) must not 
exceed your operating system’s filename size limit (typically 256 characters).  
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Figure 22 - Auto-Saving Dialog 

3.6.17 INFINITY3 Camera Cooler Control 
All the new INFINITY3 based cameras are able to cool down the sensor to 
improve its noise response with longer exposures. To turn on this feature, select 
the Cooler On option of the Camera menu. The blue light on the front of these 
cameras indicates when the camera coolers are on and running. 
 

 
Figure 23 - INFINITY3 Camera Cooler Option 

These cameras can also report their current sensor temperature. The Cooler 
Settings… option provides the current sensor temperature of the camera. These 
cameras are able to cool to about 30°C below ambient temperature of the 
camera surroundings. 
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Figure 24 - Cooling Settings Option and Dialog 

3.6.18 AVI Capture Settings 
Not only can you capture individual images but you can capture a video clip from 
the camera and save it to an AVI file.      
To begin capturing video clips, first configure the AVI capture settings. Hitting the 
API Capture Settings button brings up the dialog shown in Figure 25.  
 

 
 

 
Figure 25 - AVI Capture Settings Dialog 

Copyright © 2007  Page 27 



Lumenera INFINITY CAPTURE   
User’s Manual  Release 4.5 

Select a filename and location for the AVI video clip. Next select the video file 
type for the AVI file. Note there are four types available as shown in Figure 26.  
Note: The XviD AVI file type requires the installation of a third-party AVI 
compression filter. It is available from the following website, 
www.koepi.org/xvid.shtml. For more information on this AVI compression filter 
visit www.xvid.org.  

 
Figure 26 - AVI Video File Types 

Select the duration of the video clip you wish to capture. You have the option of 
having the video preview to the screen while capturing the video clip. Note that 
having this option selected may slow down the camera frame rate and result in 
lower frame rates in the captured video clip. 
Note: Setting the duration to large values can create extremely large files, 
depending on the camera resolution and frame rate. To minimize this, you may 
want to reduce the preview window size when capturing video clips.  

3.6.19 Capturing AVI files 
 

 
 

Once you have setup the AVI capture settings, you can begin to record your 
video clips. The video will be saved to a temporary file containing the raw vide 
images captured from the camera. This temporary file can be viewed directly by 
the INFINITY CAPTURE’s AVI File Playback.  
Note: To view this file with other AVI playback applications, you will need to 
convert this file to a standard AVI file or compress it with the XviD filer (see 
section 3.6.18 for more information on this AVI compression filter). 
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3.6.20 AVI File Playback 

 
 

You can playback any type of .avi file with the INFINITY CAPTURE’s AVI 
playback feature. This feature can playback raw files that were captured from 
your INFINITY camera that have not been converted to a standard AVI file. 

 

 
Figure 27 - AVI Playback Dialog 

The INFINITY CAPTURE AVI playback dialog allows you to play, pause, stop 
and scan to any location in the AVI file. You can rewind and fast-forward through 
the AVI playback through the slider control provided. 

3.6.21 Converting AVI files 
The INFINITY CAPTURE can capture, convert and save .avi files in one step. 
You can also capture only the raw data from the camera and convert it at a later 
date. To do this, select the Convert AVI File… from the options menu. 
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Figure 28 - AVI Convert Dialog 

In the Input File Name, select the RAW AVI file that was captured previously, as 
shown in Figure 28. In the Output File Name, select or provide a destination AVI 
file name. Finally, select the video file type you want the output file to be and hit 
the Convert AVI button.  

3.7 Using INFINITY Cameras with TWAIN 

Many programs support camera control and image capture directly using the 
standard TWAIN protocol.  Paint programs, Microsoft Office applications as well 
as a wide variety of scientific software applications identify and run the INFINITY 
cameras through the supplied TWAIN interface. 
The operation of the TWAIN interface is virtually identical to the INFINITY 
CAPTURE application.  The only difference is that when you capture an image, 
instead of displaying in on screen, it passes it to the underlying TWAIN enabled 
application.  There is no facility to save images directly to a file using the TWAIN 
interface. 
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